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Chapter 1 OVERVIEW 

Section A - An Introduction to Job Scheduling 
 
The Program/Project Management System (P/PMS) was designed and built to assist the Department in 
planning and scheduling the pre construction design process for trunk line road and bridge projects.  Once a 
project is selected, the project manager enters the characteristics describing the project into the system.  The 
system then creates a scheduling network using those characteristics, and using the standards provided by 
the Department's operational and supporting units, to determine which tasks will be included in the network 
and what the durations should be.  At the same time, the people required to perform the task are identified 
and added to the schedule.  Following this generation process, project managers may need to further refine 
the schedule since all projects are unique in some way.   
 
When schedules have been created and refined, they can be pulled together to summarize, analyze, and 
report on jobs, tasks, resources, and costs throughout the Department.  Project schedules are brought 
together in the system's Program Area where system and program managers can assess the impacts of 
progress, changing schedules and organizational changes.  Some information from the project schedules is 
automatically rolled together and presented in the Executive Information System where users can quickly 
review and evaluate what's going on with all projects.  Please refer to the EIS Users Guide for more details 
on that application. 
 
This document is intended to be an informal guide that explains how to DO each of the steps described 
above, and more.  The following chapters were pulled from the Combined Quick Reference/Learning Guide 
to deal specifically with how to perform some of the more common tasks in the P/PMS Administrative Area 
(for Application Administrators).   This guide will sometimes assume a certain minimal level of knowledge 
about P/PMS and its usage and functionality.  It is recommended that the user take the P/PMS Training 
Course before utilizing this manual, especially for the Project Manager and Program/System Manager 
portions.  If you have more questions, please call the P/PMS Hotline at (517) 373-9020. 
 
Throughout the document, reference will be made to other familiar P/PMS manuals.  Many P/PMS manuals 
exist to cover system functions, menu structures, task standards, job characteristics and much more.  The 
intent of this manual is to provide answers to most questions in a concise, easy to find way.  In many cases, 
one of the other manuals will provide detail that will not be reproduced here.  Current manuals can be found 
on the intranet at http://interchange/computing/design/ppms.htm 

Section B - Conventions 
 
Throughout this document information will be presented using the following basic standards: 
 
 Menu options will appear in bold with initial upper case letters (e.g.  File, New, Job where underlined 
letters are hot keys and menu selections are separated by commas). Items of special note will be preceded by 
Note: and/or will be underlined or italicized. Figures are identified by number, and the figure numbers start 
over for each chapter 
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Chapter 2  APPLICATION ADMINISTRATORS 

Section A - How to Get Into P/PMS 
 
Purpose:  The purpose of this section is to detail the steps for getting into P/PMS to start working with 

jobs. 
 
Before You  
Begin:  If you do not have P/PMS, contact the P/PMS Support Team to get the software installed and 

a login password.  You will be notified when your login is available.  If it is desired, Support 
Team personnel can set up your PC to bypass the login/password screen.  Please contact us 
with any questions regarding P/PMS! 

 
P/PMS Support Team Personnel:  HOTLINE: (517) 373-9020 
Dennis Kelley (517) 373-4614 User/Printer Administration & 

Technician 
Norm Kieliszewski (517) 335-1913 Design Expert/engineering Technician 
Lenny Robinson (517) 335-3291 Consultant 
Scott Habetler (517) 335-3278 Consultant 
Kelly Rogers (517) 335-2065 Consultant 
Ellie Parker (517) 241-0384 Student Help 

 
Procedure:  Follow these steps to get started with P/PMS. 
 

Step Action 
1 Double-click the P/PMS icon on your desktop. 

If... Then... 
A. A login screen 

appears 
Type in your login 
name, ENTER, and 
your password, and 
proceed to the next 
step. 

B. The Main Menu 
appears 

Proceed to the next 
step.   

2
  

Click the P/PMS button on the Main Menu window, like the one in the figure 1 
below. 

 
Figure 1 
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Section B - How to Provide User Access or Updates 
 
Purpose:  This section provides information and steps about how to add and update users to P/PMS. 
 
Before You  Users are provided access to the system in a two part process.  First, the user’s name and 
Begin: login information is given to the P/PMS System Administrator to be allowed access to the 

server on which P/PMS resides.  Second, the Application Administrator (AA) needs to 
provide the user with access to the various portions of the PPMS system as required.  
Information is provided by the user via the System Access Form.  With this information, the 
AA can work in the User Administration Area, accessed from the Main Menu. 

 
Procedure: To add a new user, perform steps 1-9.  To update a user, perform steps 10-14 (next page). 
 

Step Action 
 

1 New user fills out System Access Form and sends it to Application Administrator. 
2 AA notifies System Administrator (SA) of user=s name and login to be added, plus 

a default password. 
3 SA notifies AA once the user is added. 
4 AA enters User Administration Area through Main Menu.  See Figure 2 below. 
5 Click on Add User. 
6 The Administrator will be presented with a pop menu list of all users who have 

been added to the system, but not granted access to the various areas of P/PMS.  
Click on the user to give access to and click OK.  This will now fill in their name 
and log name. 

7 Fill in the remaining information from the P/PMS Request for System Access form 
or based on personal communications with the user. 

8 Repeat the procedure for all users to be added. 
9 When finished, click Done.  Data will be updated, and you will be returned to the 

Main Menu. 
 

 
Figure 2 
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Section B - How to Provide User Access or Updates (continued) 
  
 
Procedure: 

Step Action 
 

10 To update current users, click Update User.  This will present a list of all current 
users with access to PPMS areas. 
 

11 Click on the user to update and then click OK. 
 

12 Their current access information will be presented on the screen.  Modify any 
information as necessary.  

13 Repeat this procedure for all users to be updated. 
 

14 Click Done when finished.  Data will be updated, and you will be returned to the 
Main Menu. 

 

Section C - How to Add Printers for User Availability 
 

Purpose: This section provides information and steps about how to add printers to P/PMS.  
 
Procedure: 

Step Action 
 

1 User sends request for new printer to Application Administrator.  The request must 
include: 1) the network printer name 2) the printer make and model. 
 

2 Application Administrator sends request for addition to System Administrator.  This 
request includes: 1) the network printer name 2) types of queues to set up (controlled 
by make & model).  The 4 types available are:  

A. _lj  -  regular text, 8.5"x11" 
B. _grf  -  graphics capable, 11"x8.5" 
C. _11x17  -  graphics capable, 17"x11 
D. _11x17r  -   regular text, 17"x11" 

 
3 SA notifies AA upon printer addition. 

 
4 AA notifies Lenny of completion of printer additions and any color printer types 

involved. 
5 Lenny installs printers in CAT and notifies AA of installation & printer names. 

 
6 AA contacts users to verify function of printers from P/PMS. 
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Section D - How to Modify the Global Network/Templates 
 
Purpose: This section provides information and steps about how modify the Global Network or 

network templates in P/PMS. 
 
Before You  
Begin: Editing the Global Network or network templates requires editing of the actual table of tasks 

and constraints.  You cannot use the Add/Delete Task and Constraints feature to modify 
these.  Also, it is recommended that you reference the related Network Logic Diagram and/or 
Task and Constraints Listing when making modifications. 

 
Procedure 

Step Action 
 

1 From the Administration Area, click on File, Open, Template. 
  

2 Pick the template you wish to modify from the corresponding menu. 
 

3 Select Edit, Tasks and Constraints from the menu.  All tasks and constraints will 
be presented in a spreadsheet format allowing you to access several items at once 
. 

4 Determine what modifications must be made to the template; such as what tasks 
need to added/deleted and how various constraints need to be 
added/deleted/modified. 
 

5 To Add a task, click on New.  The task needs to be in the WBS to be added. 
 

6 Type in the task number.  The description and WBS code will be filled 
automatically. 
 

7 Click on New again, and for each, add the appropriate constraints to connect the new 
task to the network.  Find or scroll through existing tasks if necessary, or consult the 
Network Logic Diagram of the Global Network or Template. 
 

8 To Delete a task, go to the row containing the task, and click Delete. 
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Section D - How to Modify the Global Network/Templates (continued) 
 
 
Procedure 
(Continued)  

 
Figure 3 

Step Action 
 

9 Delete any constraints associated with that task by using the Find feature on the Prev 
Task and Succ Task Fields, using the Delete button. 
 

10 Reconnect any tasks that came before and after the deleted task so that the logic of 
the network will be kept. 
 

11 To Modify a constraint, go to the row containing the constraint to be modified. 
 

12 You may change the predecessor or successor task, or constraint type for each 
modification. 
 

13 Click on Exit when finished. 
 

14 Click Process, Analyze Template.  If the analysis process passes, the template can 
then be used to generate a network. 
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Section E - How to Add a New Task to P/PMS or Edit Existing Tasks 

 
Purpose: This section provides information & steps about how to add a task and its standards in 

P/PMS. 
Before You  
Begin: To add a new task in P/PMS first requires a written description and collection of standards 

data.  This procedure is outlined in the Task Manual.  For each of the following Parts, editing 
will follow the same general procedure, but you will find and edit rows of existing 
information.  The same menu picks can provide existing information under Listings. 

 

Part I - Task Addition and Task Base Standards 
 
Procedure  

Step Action 
 

1 From the Administration Area, click on Edit, Work Breakdown Structure.  You will 
see a window as in Figure 4. 

 
Figure 4 

2 Locate and identify the correct WBS Parent for the task, and click on New.  
 

3 Enter the WBS Code, WBS Description, and Task Number. 
 

4 Repeat steps 2 and 3 for all new tasks. 
 

5 Hit and up or down arrow when done to save, and then Exit. 
 

6 Click on Edit, Standards Tables, Task Base.  
 

7 You will be prompted to choose a specific Task Number and/or Job Type to edit, if 
you wish.  Then you will see a window as in Figure 5 (next page). 
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 Section E - How to Add a New Task to P/PMS or Edit Existing Tasks, (continued) 
 

8 Click on New for the first row of data; you may use Copy for subsequent rows. 
 

9 Enter a row for each Job Type, containing the Task Number, Job Type, Base 
Duration and Labor Hours, and Construction Length and Structure Multipliers as 
gathered from the standards collection. 
 

10 Repeat for subsequent rows of data. 
 

11 Exit when finished. 
 

 
 
  

 
Figure 5 
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Section E - How to Add a New Task to P/PMS or Edit Existing Tasks (continued) 
 

Part II - Task Work Group Standards 
 
Purpose: This section provides information and steps about how to add a task=s Work Group 

standards in P/PMS. 
 
Procedure  

Step Action 
 

1 Click on Edit, Standards Tables, Work Group.  
 

2 You will be prompted to choose a specific Task Number, Job Type, or Work 
Group combination to edit, if you wish.  Then you will see a window as in Figure 
6. 
 

3 Click on New for the first row of data; you may use Copy for subsequent rows. 
 

4 Enter a row for each Job Type/Work Group combination that contains the Task 
Number, Job Type, Work Group, and associated Duration and Labor Hours 
Multipliers.  
 

5 Use the data gathered from the standards collection.  Note: Non-zero multipliers 
indicate involvement; these are often 1. 
 

6 Repeat for subsequent rows of data.  Exit when finished. 
 

 
Figure 6 
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Section E - How to Add a New Task to P/PMS or Edit Existing Tasks (continued) 
 

Part III - Task Region Standards, and More 
 
Purpose: This section provides information and steps about how to add a task=s Region standards in 

P/PMS. 
 
Procedure  

Step Action 
 

1 Click on Edit, Standards Tables, Region.  
 

2 You will be prompted to choose a specific Task Number, Job Type, or Region 
combination to edit, if you wish.  Then you will see a window as in Figure 7. 
 

3 Click on New for the first row of data; you may use Copy for subsequent rows. 
 

4 Enter a row for each Job Type/Region combination that contains the Task Number, 
Job Type, Region, and associated Duration and Labor Hours Multipliers.  
 

5 Use the data gathered from the standards collection.  Note: Non-zero multipliers 
indicate involvement or application; these are often 1. 
 

6 Repeat for subsequent rows of data.  Exit when finished. 
 
 

As you can see, there is a pattern to this procedure 
for adding standards.   

Follow this same pattern for entering the task 
standards for: 

Environment Type 
Road Class 
Traffic Level 
Development Class 

  
 

Figure 7 
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Section E - How to Add a New Task to P/PMS or Edit Existing Tasks (continued) 
 

Part IV - Task Additives 
Procedure  

Step Action 
 

1 Click on Edit, Standards Tables, Task Additives. 
 

2 You will be prompted to choose a specific Task Number and Additive Code to edit, 
if you wish.  Then you will see a window as in Figure 8.  
 

 
Figure 8 

 
3 Click on New for the first row of data; you may use Copy for subsequent rows. 

 
4 Enter a row for each Task Additive to be added, containing the Task Number, 

Additive Code, and the Added Duration and/or Labor Hours for that Additive.  This 
information should have been gathered in the standards data. 
 

5 
 
 
 
 

 

 

If... Then... 
A. The additive contains 

additional labor hours 
Go to Step 6. 

B. The additive only 
contains an additional 
duration 

Go to Step 8. 

6 Drop to the Subrecord. 
 

7 In the Subrecord, identify by organizational code the resources that the additional 
labor hours apply to 

8 Repeat Steps 3 - 5 for each Additive. 
9 Exit when finished. 
10 Make sure the coding to include the additive gets added to the Network Generation 

Program. 
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Section E - How to Add a New Task to P/PMS or Edit Existing Tasks (continued) 
 

Part V - Task Switches 
 
Procedure  

Step Action 
 

1 Click on Edit, Standards Tables, Task Switches. 
 

2 You will be prompted to choose a specific Task Number and Switch ID to edit, if 
you wish.  Then you will see a window as in Figure 9. 
 

3 Click on New for the first row of data; you may use Copy for subsequent rows. 
 

4 Enter a row for each Task Switch to be added, containing the Task Number, Switch 
Code, and a Multiplier of zero (switches turn tasks off in certain instances).  This 
information should have been gathered in the standards data. 
 

5 Repeat for each Switch. 
 

6 Exit when finished. 
 

7 Make sure the coding to include the switch gets added to the Network Generation 
Program. 

 

 
Figure 9 
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Section E - How to Add a New Task to P/PMS or Edit Existing Tasks (continued) 
 

Part V - Task Switches 
 
Procedure  

Step Action 
 

1 Click on Edit, Standards Tables, Resources Assigned. 
 

2 You will be prompted to choose a specific Task Number, Work Group, and 
Resource Code to edit, if you wish.  Then you will see a window as in Figure 10. 
 

3 Click on New for the first row of data; you may use Copy for subsequent rows. 
 

4 Enter a row only for each Work Group, to which the task applies, containing the 
Task Number, Work Group, Resource, and the % of total labor hours the resource 
receives on In-House and Consultant jobs.  This information should have been 
gathered in the standards data. 
 

5 Repeat for each Task/Work Group/Resource combination. 
 

6 Exit when finished. 
 

 
Figure 10 
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Section E - How to Add a New Task to P/PMS or Edit Existing Tasks (continued) 
 

Part VI - Other Task Standards Questions/Procedures 
 
 

1. How do I know if/when task standards should be changed? 
 

Standards Validation is a periodic and ongoing process, but specific standards may need 
exploration in the event that a Project Manager or unit leader points out a specific difficulty with 
their tasks and/or networks.  Discussions between the initiator, Application  

  
Administrator, and P/PMS Support Personnel should help determine if there is a change in the 
way a task is being performed or business is being done that warrants a standards change. 

 
 

2. How do I know if a new switch or additive is necessary? 
 

The need for a new switch or additive is situational dependant.  A switch is used to remove a task 
from a network if certain conditions are met.  An additive increases duration and/or labor hours 
for tasks that meet certain criteria.  Typically, the need for a new switch or additive is discovered 
by a Project Manager or unit leader pointing out a specific difficulty with their tasks and/or 
networks.  If the difficulty can not be rectified by means of deleting tasks, use of any governing 
characteristics, or any existing PPMS conventions and processes, a new switch or additive may 
be the best solution, but all possibilities should be considered and explored  
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Section F - How to Control Who Has Access to Jobs 
 
Purpose This section provides information and steps about how to control which users have access to 

specific jobs in P/PMS. 
 
Before You  
Begin These are procedures in addition to the control provided through the different P/PMS user 

types.  One method is automatic - the assignment of access to Project Managers for their jobs 
in the system is performed by picking up the information nightly from MPINS and 
synchronizing with it.  While the PM permissions are shown in P/PMS, they are not able to 
be changed.  Only the additional accesses may be modified.   

 
Note: Access given to the main job (Version 1) will be extended through all versions, and 
vice versa.  It is not possible to provide access to only a version. 

 
Procedure  

Step Action 
 

1 Click on Edit, Job Access. 
 

2 You will see a window as in Figure 11. 
 

3 Find the job or project manager of jobs for which you want to modify access. 
 

4 From the row containing the job number, select Subrecord. 
 

5 In the User Name field, enter the user’s P/PMS login who you wish to have access to 
that job/version. 

6 Repeat Steps 3 - 5 for each job you wish to modify access for. 
 

7 Exit when finished. 
 

 

 
Figure 11 
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Section G -  How to Quit, Close, Exit, Log Off or Out, or Otherwise Leave the System 
 
 
Procedure Step 

 
Action 

 
1 Choose Exit from the File menu.   

 
1. Note that it is not necessary to close your template, job, scenario, or 

program session before exiting.   
 

2. Use of the Windows Control button (the x sign in the upper right of 
the window) to close windows is not recommended, as this will kill 
your session abnormally, and may leave things running on the P/PMS 
server which may preclude you from accessing the system later, or 
preclude other users from accessing certain system data. 

 



P/PMS Quick Reference/Learning Guide 

APPLICATION ADMINISTRATORS 2-16 
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Chapter 3 APPENDICES 

Appendix A - The View File Window 
 

The window, in which listings and reports are displayed, shown below, is called the View File window. 
 
This screen allows you to: 
 

1. Scroll up and down the listing using the vertical scroll bar 
 

2. Scroll right and left in the listing using the horizontal scroll bar 
 

3. Search for a text string in the listing 
 

4. Print the listing 
 

5. Save the listing to a file 
 

6. Display listing files you have saved (by clicking on Utilities, View a File) 
 

 
You can also maximize the View File window to see a larger part of the listing. 
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Appendix A - the View File Window, continued 
The menu bar at the top of the screen gives you access to three menus:  
 

• File 
• Goto 
• Help 

 
In addition, there are seven buttons at the bottom of the screen. The functions assigned to menu items and 
buttons are summarized below. 
 

MENU BAR FUNCTIONS: VIEW FILE WINDOW 

MENU MENU ITEM FUNCTION 
File 
 Print Prints the listing on the default printer. 
 Save As  Saves the listing to the file you specify in the Prompt 

pop up window. 
 Exit Closes the View File window and returns you to the 

P/PMS area window. 
Goto 
 Top Moves the View File window to the top of the listing. 

 
 Bottom Moves the View File window to the bottom of the 

listing. 
 Left Moves the View File window to the left side of the 

listing. 
 Right Moves the View File window to the right side of the 

listing. 
Help 
 About Viewfile Displays information about the View File window. 
 About Windows Displays information about X Windows. 

 

BUTTON BAR FUNCTIONS: VIEW FILE WINDOW 
BUTTON FUNCTION 
EXIT Closes the View File window and returns you to the P/PMS area 

window. 
CONTINUE Allows processing to continue in the P/PMS area window. 
SELECT Displays in a View File window the file you select in the File 

Requestor pop-up window. 
ANOTHER Displays a selected file in another View File window. 
FIND Searches for the text string you enter in the Prompt pop-up window. 
REPEAT Searches for the next occurrence of the text string. 
PRINT  Prints the listing on the printer you select from the pop-up window. 
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Appendix B - Constraint Types 
 
Constraints are the means which will be used to show how the activities relate to each other.  The following 
diagram lists the major types. 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Finish to start means that activity B cannot start until activity A is finished.   
 
Start to Start means that Activity A must start before activity B can start.   
 
Finish to Finish means that Activity B cannot finish until activity A finishes.   
 
 
Each of these types of constraints may also contain a delay inserted between the two tasks involved. 
 
There is one other kind dependency that exists - Start to Finish - but it is rarely used, so it is not included in 
the above. 
  
  

A B A B

A B

Finish to Start Start to Start

Finish to Finish  
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Appendix C - Glossary of Terms 
 
2604 Form.  A change request form in MPINS used to obtain authorization for such changes to a job as 
adding or deleting phases, and splitting a job, as well as changes to a job=s cost, major work type or work 
performed, location, financial cost divisions, and major milestone dates.  This form is usually submitted 
before creating a version of a job.  (See Version) 
 
Actual Finish Date (AF) - The actual point in time that work is finished on a task.  (Note: in some cases, 
the task is considered “finished” when work is “substantially complete”). 
 
Actual Start Date (AS) - The actual point in time that work started on a task. 
 
Approved Finish Date - The target point in time that work should finish on a task in order for the job to 
meet its targeted plan completion date. 
 
Approved Start Date - The target point in time that work should start on a task in order for the job to meet 
its targeted plan completion date. 
 
Characteristics - Items in the scope of a job that make it unique, including work type and region, road 
class, FHWA involvement, subgrade work or work outside existing shoulders, and many more.  
Specifically, these items of scope determine what tasks are in P/PMS job networks, their durations, and 
more.  
 
Constraint - A dependency between two tasks, or between a task and a milestone.  The four types are: 

• Finish-to-start - the “from” task must finish before the “to” task can start. 
• Finish-to-finish - the “from” task must finish before the “to” task can finish. 
• Start-to-start - the “from” task must start before the “to” task can start. 
• Start-to-finish - the “from” task must start before the “to” task can finish. 

 
Construction Cost - The programmed A-phase amount minus the estimated Construction Engineering (CE) 
amount.  Both values are retrieved from the MAP database and are shown on the MPINS Job Info Screen. 
 
Critical Path - The series of activities determining the earliest completion of the project.  The critical path 
will generally change from time to time as activities are completed ahead of or behind schedule.  Although 
normally calculated for the entire project, the critical path can also be determined for a milestone.  The 
critical path is usually defined as those activities with float less than or equal to a specified value, often zero. 
 
Duration - Number of work days (not including holidays/other non-working days) required to complete a 
task. 
 
Float - The amount of time, in days, that a task may be delayed from its approved dates without delaying 
the project finish date.  Float is a mathematical calculation and can change as the project progresses and 
changes are made to the project.  Also called slack time, total float, and path float. 
 
Generic Job - A job containing all of the tasks, milestones, and constraints necessary to constitute a 
network, but missing the necessary Management Units to finish assigning all resources to tasks. 
 
Job Schedule - The planned dates for performing the tasks and for meeting the milestones. 
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Appendix C - Glossary of Terms (continued) 
 
Labor Hours - The amount of actual “hands-on” time a resource (work unit) spends performing a task or 
group of tasks. 
 
Letting - The date that a job is put up for bid by contractors. 
 
Management Units - Work units (resources) involved in major portions of a job & the P/PMS network of 
tasks. 
 
MAP - Michigan Architectural Project.  The MDOT corporate database. 
 
Milestone - A significant event in the job, usually the completion of a major deliverable. 
 
MPINS - Michigan Project Information System.  The user interface to the MAP database. 
 
Network Analysis - The process of identifying early and late start and finish dates for the uncompleted 
portions of project activities. 
 
Network Logic Diagram - A schematic display of the logical relationships of project tasks.  Always drawn 
from left to right to reflect project chronology.  Often referred to as a “PERT chart”. 
 
New Job - A valid job whose basic data has been loaded from MAP and needs a P/PMS network created.  
Valid jobs include: 

• Concepts with job numbers not beginning with 9, with valid P/PMS work types, region codes greater 
than 0, and which will be let by MDOT during or after the current fiscal year. 

• Approved or active trunk line jobs, with job numbers not beginning with 9, valid P/PMS work types, 
region codes greater than 0, and which will be let by MDOT during or after the current fiscal year 
(or Study jobs). 

 
Plan Completion - The date at which all plans are complete, and the job is turned in to Specifications and 
Estimates for packaging to be advertised and let. 
 
P/PMS - The Program/Project Management System. 
 
Program - A group of related projects managed in a coordinated way.  Programs usually include an element 
of ongoing activity. 
 
Programmed Job - A job that has been approved and added to the P/PMS Statewide Program.  These jobs 
require updating and monitoring for progress. 
 
Project - A temporary endeavor undertaken to create a unique product or service. 
 
Project Management - The application of knowledge, skills, tools, and techniques to project activities in 
order to meet or exceed stakeholder needs and expectations from a project. 
 
Project Manager - The main person responsible for developing schedule & plans for a job/group of jobs. 
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 Appendix C - Glossary of Terms (continued) 
 
Refined Job - A job that has a version waiting to be included in the P/PMS Statewide Program.  The 
version must have satisfactory dates and/or coincide with an approved 2604 before it can be “programmed” 
n P/PMS. 
 
Resource – A unit that performs at least some of the work on the task or tasks they=re involved with. 
 
Scheduled Finish Date - The planned point in time that work will be finished on a task. 
 
Scheduled Start Date - The planned point in time that work will be started on a task. 
 
Scheduling Specialist - The “right-hand” of a project manager, whose duty with regards to P/PMS is to 
perform the ground work necessary to create and update the P/PMS network for a job. 
 
Target Date - An imposed date which constrains or otherwise modifies the network analysis.  Target dates 
are set approved dates from which the network schedule is calculated.  These include the Target Start (Task 
0000), Target Plan Completion, Target Letting, Target Finish (Task 9999), and Target Float. 
 
Task - An element of work performed during the course of a project.  A task has an expected duration, and 
expected cost, and expected resource requirements. 
 
Ungenerated Job - A job that has been opened in P/PMS.  The job may even have some characteristics 
entered, but does not yet have a network generated. 
 
Unrefined Job - A job containing all of the tasks, milestones, constraints, and resources necessary to 
constitute a network, but that needs to be checked, updated, and verified to ensure the network correctly 
reflects all work to be done. 
 
Version - A copy of a job network, with which a project manager or scheduling specialist is able to make 
changes to the network.  This is sometimes utilized to perform a “what-if?” scenario. 
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Appendix D - Entry of Actual Start and Finish Dates 
 
Other than in P/PMS itself, actual start and finish dates get to us through MAP from other systems, MPINS, 
and now from DCDS.  The MPINS and DCDS methods are presented here. 

How to assign an employee to a P/PMS Task in MPINS 
 
This function can be performed by the Supervisor of the Unit for an employee assignment to be made. 
 

1. Identify the job record for which an employee assignment is to be made as described in How to 
Identify Desired Records. From the Job List, select Job/Phase Task Status from the menu bar, and 
in the Job Locator select Jobs and Phase Task Status. 

 
2. In the Phase Tasks section of the Phase Task Status window, use the vertical scroll bar to locate and 

select the PPMS Task Number/Unit record in which an employee assignment is to be made. 
 
3. In the Task Status section of the window use the pick list associated with the Employee field to 

select the employee to be assigned to the task. 
 
4. Save the changes by clicking on the Save tool bar button. 

 
 

 
5. Repeat from step 2 as desired. When done, the user can close the window by 

clicking on the Close tool bar button. 
  

 

How to record dates for P/PMS Tasks in MPINS 
This function can be performed by the Unit Leader or Project Manager for a given job, and by the 
Supervisor of the Unit or an employee they designate as assigned to the Task. 
 

1. Open the Job Locator by clicking on the Job Loc. tool bar button.  The Job Locator window opens, 
as illustrated here.  

 
2. Select Job at the top of the above window. 

 
3. Enter the desired job number in the Job # field. 

 
4. Select Phase Task Status in the Locate section of the 

window. 
 

5. Select OK at the bottom of the window to proceed. 
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Appendix D - Entry of Actual Start and Finish Dates (continued) 
 

6. The Phase Task Status Screen opens, and defaults to select Incomplete Tasks. 
 
7. In the Phase Tasks section of the Phase Task Status window, use the vertical scroll bar to locate and 

select the PPMS Task Number/Unit record in which dates are to be recorded. 
 

8. In the Task Status section of the window enter any of the Est. Completion Date, Actual Start 
Date, Actual End Date fields as appropriate. 

 
9. Save the changes by clicking on the Save tool bar button. 

 
10. Repeat from step 2 as desired. When done, the user can close the window by clicking on the Close 

tool bar button.        
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Start and Finish Dates in DCDS 
 
The P/PMS Team has developed a way for users to input P/PMS task start and finish dates through DCDS 
(current methods of entering actuals in MPINs and P/PMS are still supported).  Task actuals can now be 
entered through the Multi field in DCDS.  This is accomplished by entering a 5 digit code SMMDD or 
FMMDD where S indicates a start, F indicates finish, MM represents the month and DD represents the day.  
In the case that a task was started and finished during the same pay period the two codes can be combined 
resulting in SMMDDFMMDD.  For the example below: 
 
S0612 - would be an actual start date of June 12, 2000 (year from pay period) for task 3310. 
F0622 - would be actual finish date of June 22, 2000 for task 3310. 
S0612F0616 - would be a Start and Finish in the same pay period for task 2320.  
 
AG1 (task code), Project (Job Number) and Index (old Org. Code) fields must be present for the actuals to 
be valid.  The Index (old Org. Code) will be checked to insure that the unit listed is the Responsible Unit for 
the task. 
 
Note: A delay of up to 3 weeks is possible for P/PMS to receive the DCDS information. 
  

  



P/PMS Quick Reference/Learning Guide 

APPENDICES 3-10 

Appendix E - Network Logic Editor (NLE) 
 
The Network Logic Editor (NLE) is an X Windows interface enabling you to use a mouse to interactively 
create and modify a job network on the computer screen. You can use the Network Logic Editor to: 
 

• Create or delete activity boxes and constraint lines with the mouse. 
• Modify activity or constraint information through a data entry screen 
• Analyze and route a network 

 
 

Using the Network Logic Editor to modify your network 
 
To activate the Network Logic Editor after you have created or copied a network: 
 

1. Click on EDIT from the CSS main menu bar 
2. Select Network Logic Editor 

 
If you are creating a network Task by Task, the Network Logic Editor screen will appear as a blank sheet. 
 
If you have created a network by Job Type or Characteristics, the Network Logic Editor Screen will have 
the tasks that represent your network. 
 
The following will describe the operations that you can perform within the Network Logic Editor. 
  

To Add an Activity to your network 
 

1. Rest your mouse cursor on a blank area of the NLE screen 
2. Press and hold the left mouse button 
3. Drag the cursor to the right or left (about an inch) and release 

 
An activity box will be inserted into your network.  Please be aware that information will need to be added 
to this activity.  This will be explained throughout this section. 
 

To Add an Activity Constraint 
 

1. Click one time on the activity that you wish to impose a constraint.  The activity should be 
highlighted with a bolded outer edge 

2. Place your mouse cursor just inside the activity box 
3. When the cursor turns into an plus sign (+ ) , Click and hold the left mouse button. 
4. Drag the cursor to the activity with which you wish to constrain your activity 

 
Where you place and release your cursor within an activity will determine your constraint type.  The 
following describes activity constraints within the NLE. 
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Start to Start (SS) - Place the cursor on the left side of your task and draw a line to the left side of the task 
with which you wish to constrain. 
 
Finish to Start (FS) - Place your cursor on the right side of the preceding task and draw a line to the left side 
of the succeeding task.  
 
Finish to Finish (FF) - Place your cursor on the right side of the task box and draw a line to the right side of 
the task with which you wish to constrain your selected task. 
 

To view or Edit a constraint record 
1. Double click on the constraint line 

To Edit an Activity  
1. Double click in the center of the activity box 
2. Click at the bottom of the active window 
3. Make modifications (See section on modifying activity data) 

To Delete an Activity  
1. Select the activity 
2. Click on EDIT form the NLE menu bar 
3. Click on Cut to remove the activity  

 
The following chart describes the basic functions within the NLE: 

To: Action 
 

Create an activity box  Press and drag in empty space in Edit window 
Create a constraint line Press within a box: drag to another box 
Select an activity or constraint Click on desired activity or constraint 
Edit an activity or constraint Double Click on selected activity or constraint 

or 
Select activity or constraint: select Forms option 
from Data menu 

Delete  Select Item: use Cut option from Edit menu 
Move an activity When the hand icon is in an activity box, press and 

drag 
Paste Select item: use Cut or Copy: place cursor, press 

right mouse button, use Paste from Edit Utilities 
pop-down menu 

Route  Select Route option from Tools menu 
Analyze Select Analyze option from Tools menu 
Exit Select Exit option from Tools menu 
 
  
 
 


